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What’s in this Manual?

This manual provides basic project guidelines and simple 
instructions for getting started in the editing facilities.  It is not 
a substitute for other references available online, in the editing 
facility, SLC, and FMC.  You will need to access these materials 
for in-depth information about the hardware and software used 
to complete the video project.  The course teaching assistant is 
available to provide troubleshooting and instruction, but students 
are expected to take responsibility for learning to operate the 
equipment necessary to complete the video project.



Students will work in pairs to produce a 4-5 minute narrated video on the natural resource issue of their choice.  
Presentations should focus on a natural resource issue that is important to you.  The message should be 
oriented and chosen for its general appeal to a student audience.  All project responsibilities are to be shared.  
The same grade will be given to both individuals.  Students are expected to develop and use a project design 
plan.  Videos will be shown in class and critiqued by your peers.

Suggestions for a Successful Production

• Review the video production handouts and readings available in the Student Learning Center (SLC) in 
Peavy 252, pay attention to class announcements, and take advantage of the manual and other materials 
provided in the edit bays.

• Keep your project manageable; select a topic that can be dealt with in the time allowed and with the 
resources available.

• Plan ahead; make a schedule and stick to it.  The project requires a significant time investment (at 
least 20 hours), so get started early!  You will need to invest some time educating yourself about the 
cameras, editing equipment, etc.

• Find your partner’s strengths and weaknesses.  There are many aspects to this project; work together and 
utilize one another’s skills.

• Develop and use your project design plan.

• Use the video shot log provided in class to organize your footage, allowing quick and easy access for 
editing.  Fill this log out as you shoot or as you review your footage at the end of the day.

• Be sure to reserve equipment and facilities in advance, but do not use more than your fair share.  Cancel 
your reservations if your plans change so other students can make use of the time.

• Technical failures are inevitable.  Be prepared and be patient.  You can lessen the impact of a 
technical failure by planning ahead and allowing ample time to complete the project.

• Found footage is acceptable; however, the amount is limited to 30 seconds.

• Your video must utilize a narrative script.
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Project Overview

Use the next page to record contact information for the course professor and teaching 
assistant, along with important due dates for the project and your editing facility computer 
login information. ‡ ‡ ‡



Course Professor:  Dr. Bruce Shindler
Office:  Peavy 115
Telephone:  541-737-3299
E-mail:  Bruce.Shindler@oregonstate.edu

Assistant:  Ryan Gordon
Office:  Peavy 002B

E-mail:  Ryan.Gordon@oregonstate.edu

Project Due Date

Your Partner’s Contact Information

Editing Facility Login Information

Computer Assignment (C/D):_____________________

Login Name: _________________________________

Login Password: ______________________________

Important Information

FOR 391 Video Project Student Guide          Section 1-2



Equipment and Supplies Available in the FMC

The FMC houses a plethora of media equipment that is available to students, faculty, and staff.  There is 
generally one tripod available with each digital video camera kit—a good item for steady shots!  Each kit 
contains all of the items you will need to operate the camera, including a lavaliere microphone.  Other items 
available in the FMC include digital cameras, extension cords, power strips, audio accessories, and more.

You will need to purchase a mini digital videocassette (mini DV cassette) for use in the camera.  One cassette 
will record 60 minutes of video and sound.  These cassettes can be purchased (and charged to your student 
account) in the FMC.  You may also purchase cassettes at the OSU Bookstore and most variety stores 
(Fred Meyer, Bi-mart, Safeway, etc.).  The FMC also sells CD’s, CD-RW’s, DVD’s, audio cassettes, and VHS 
cassettes.

Please take care when using the FMC’s video equipment.  These cameras are a shared resource and 
replacement costs are high.  Shelter the equipment from inclement weather and unnecessary exposure to dirt, 
mud, sand, etc. Never force any moving parts; if you believe something requires maintenance, ask a member 
of the FMC staff.  Always return equipment on time, clean, with charged batteries, and ready for use by the 
next group.

Equipment & Facilities Overview
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A Note about the Video Equipment

The FMC currently supports the Canon ZR-series family of digital video cameras.  While some differences 
exist between models within the family, the cameras all function according to the same basic principles.  The 
instructions and associated illustrations in this manual may not exactly correspond to the specifications of the 
camera you are using.  Refer to the user’s manual that came with your camera if you are unable to complete a 
task based on the procedures outlined in this manual.

Peavy Hall Digital Video Editing Facility

The Peavy Hall Digital Video Editing facility offers a suite of equipment that enables users to edit and 
manipulate digital photos, audio, and video.  The facility houses two edit bays, each equipped with a 
PowerMac G5 dual 2 GHz machine capable of burning CD’s and double layer DVD’s (DVD+/-RW CD-RW).  
Both machines run iLife—Apple’s fully integrated consumer-level digital editing suite that allows seamless 
manipulation of media to produce finished products on CD, DVD, DV cassette, or VHS cassette.  iLife consists 
of iMovie, iDVD, iTunes, iPhoto, and GarageBand.  GarageBand is a standalone consumer-level package that 
enables users to author their own musical compilations from an extensive library of digitally looped sounds.  
For more advanced users, both computers offer FinalCut Express, LiveType, and Soundtrack for prosumer 
level video and audio editing capabilities.

This manual provides basic directions for operating the facility’s hardware and a brief introduction to iLife, with 
greatest emphasis placed on iMovie and iDVD.  You are encouraged to utilize documentation available in the 
editing facilities for in-depth iLife tutorials.  For the purposes of FOR 391, your teaching assistant will only 
provide technical support for the facility’s hardware, iMovie, and iDVD.

Refer to the following sections for additional information about the equipment, facilities, and the regulations that 
govern their use.



Canon digital video cameras and other video equipment may be reserved and checked out through the Self-
Learning Center (SLC).  Cameras may only be picked up when the Forestry Media Center is open (see 
hours below).  Please observe the following guidelines when reserving and using the video equipment:

• Cameras may be checked out from the FMC in two-hour increments for a maximum of 24 hours.  
Cameras may be kept over the weekend if you sign them out on Friday afternoon (about 4 PM) and return 
them Monday morning (about 8 am).

• Don’t return a camera late!  If a camera is not back in time for the next user, you will be charged $50.00 
per day (the cost of renting a camera form the University’s media center), whether it’s 5 minutes or 6 
hours late.

• Don’t forget a tripod.  Each time you check out a camera, you may also take a tripod.  The tripod is 
important for steady shots.

• Always return a camera with fully charged batteries and be sure all equipment is back in the bag.  You 
are responsible for all the equipment you borrow and will be charged replacement cost for anything that is 
missing.  The next user should be ready to use the equipment without any snags.

• The lavaliere microphones (there is one with each camera) are operated by batteries and have an on/off 
switch.  Be sure to turn the switch off when you are no longer using the microphone.  If the batteries 
go dead, you should replace them or notify FMC staff when you return the camera.

• Always check the equipment before you go out to collect footage.  Be sure you have everything you 
need and that it is all working properly.  Notify FMC staff if something is missing or broken.

• The cameras and associated equipment are not waterproof.  Take care to protect them from moisture 
and extreme temperatures.

• Care for all of the equipment as if it were your own.

Forestry Media Center (FMC):  Peavy 250

Hours:  Monday - Friday 8 AM to 12 PM; 1 PM to 5 PM

Accessing Digital Video Cameras
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Important Tip

A stuck or damaged DV cassette is most likely related to the formation of condensation on the camera’s internal 
components.  The cameras are susceptible to drastic changes in temperature and humidity.  When transported 
across an extreme environmental gradient, condensation may form inside the camera and cause the tape to 
become stuck/jammed.  This condition will damage your tape (ruining your footage) and could potentially damage 
the camera.  As a general rule, eject your tape immediately after filming in a damp/humid environment; do not 
operate the camera until it has been acclimated in a warm, dry area.  The tape must be removed; the components 
will not fully dry while the tape traps condensation on the internal mechanisms.



There are two editing bays in the basement of Peavy Hall.  These facilities may be reserved in the Student 
Learning Center (SLC).  Please observe the following guidelines when reserving and using the editing facilities:

• Edit bays may be reserved for no longer than two hours.  You may continue working past your 
reserved time if no one has the facility reserved following your block.  You may stay and work longer in the 
evening if you check out the last block of time, but you cannot remain in the building all night (for security 
reasons).  Return keys to the book drop outside the SLC after hours.  Do not keep keys over night or 
over a weekend.

• You and your partner will be assigned to one of two Macintosh computers in the facility.  Your group will 
be given its own login account and a folder on the external hard drive.  It is important you keep all your 
work in this folder.

• Be respectful of how much video you store on the hard drive.  One minute of digital video requires 
approximately 180 MB of storage space!  The computers have limited storage space; if you use too much, 
there may not be enough for other groups to complete their work.  Consider storing most of your video on 
a DV cassette and retrieve shots when you need them for a specific segment.  Delete video you no longer 
plan to use.

• Save often!  The computer will not automatically save your work.  If the power fails or your computer 
freezes, you could lose your work.  As a general rule, it is a good idea to save every 10-15 minutes.

• Keep the edit bay facilities clean and orderly.  FOOD AND DRINKS ARE NOT ALLOWED IN THE 
EDITING FACILITIES.  Please turn off all equipment, shut off the lights, and lock the door before you 
leave.

Digital Video Editing Facilities:  Peavy 030C and 030D

Student Learning Center (SLC):  Peavy 252

SLC Hours of Operation: Monday - Thursday 8:15 AM - 10 PM
 Friday 8:15 AM - 5 PM
 Saturday CLOSED
 Sunday 1 PM - 9 PM

Accessing Editing Facilities
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Important Tip

Your login account helps protect your work by limiting access to your working folders; your files can only be altered 
by someone with your password.  Please save all of your work in your folder on the external hard drive.  If you 
should “misplace” a file, choose “Find...” from the File menu while in the Finder view.  Enter any details about the 
file’s name, extension, etc. into the dialog box to initiate a search.  The computer will return results based upon any 
unique identifying information you can provide.  Once located, move the file to a known location.



Loading the Battery & Cassette

You will need to attach a charged battery to the 
camera before you can load a DV cassette or use 
any camera functions.  To attach the battery, flip up 
the viewfinder (6), orient the battery contacts so they 
will align with the contacts on the camera (5), and 
slide the battery into place.  To remove a battery, 
press the gray release button (4) and gently slide the 
battery out.

To load a DV cassette, you should flip the camera 
upside-down (8).  Be sure your hands and all other 
obstructions are free of the opening and then use the 
button (9) to release the casing.  Once the casing 
is fully open, the camera will extend and open.  
Carefully insert the cassette with the top down and 
the spools facing the inside of the camera.  Gently 
close the camera; close the casing once the camera 
has fully retracted.  DO NOT FORCE THE TAPE 
MECHANISM--it is very fragile.

Basic Operation

The silver switch surrounding the large red button (3) 
allows you to turn the camera on and off and select 
the operation mode.  When switched to “Camera,” 
the camera will record; when switched to “VCR,” the 
camera will play from the cassette (for review on the 
LCD or an external monitor).

When filming, press the large red button to start and 
stop recording (3).  The zoom is operated with the 
gray toggle switch near the top of the camera (2).  
When in VCR mode, the camera is controlled with the 
buttons located above the LCD display (7).

The LCD display (7) can be used for filming and 
playback.  The viewfinder will not function when the 
LCD display is extended.  You may find it best to use 
the viewfinder when operating in bright light.  The 
LCD display swivels for custom adjustment, but be 
careful--it’s fragile!
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Camera Equipment Operation
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Charging Batteries

There is not a separate charging base for the batteries; they are charged 
on the camera.  To charge the batteries, plug the AC adaptor (1) into a 
wall socket.  Then, plug the adaptor (2) into the DC power input…located 
beneath the LCD display on the ZR-20 (3)…on the side of the camera with 
the other media inputs on the ZR-45 (4)…and below the battery mount on 
newer models.

Using a Tripod

To mount the camera on a tripod, attach the tripod’s base plate to the 
camera by threading it into the receptacle (8) on the bottom of the camera.  
Be careful not to strip the threads and do not force the base plate to turn.  
Once securely threaded, the base plate will attach the camera to the tripod 
and allow quick mounting/removal.  Do not forget to remove the base plate 
before returning equipment to the FMC!

External Microphone & Other Features

You will rely upon the media inputs (4) to use the lavaliere microphone and 
the analog video out feature (5).  The lavaliere microphone operates on a 
battery and has an on/off button.  If it is not turned off, the battery will go 
dead.  When plugged into the mic input (red), the lavaliere microphone will 
override the built-in microphone.  You may wish to monitor sound by plugging 
the earbud into the A/V input (yellow).  The A/V input is also used to play 
video from the camera onto a TV or VCR.  Plug the single “mini jack” of the 
A/V cable (5) into the A/V input.  Connect the RCA cables to the appropriate 
jacks on the TV or VCR.  Place the camera in VCR mode and operate as 
you normally would to review video on your DV cassette.  You may need to 
change menu settings in the camera to switch between the headphone and 
analog video out features; refer to the user’s manual for more information.

To connect the camera directly to a computer with a FireWire cable, plug the 
4-pin (small) end of the FireWire into the front of the camera (7).  The 6-pin 
(large) end of the FireWire should be plugged into the computer.
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Camera Equipment Operation
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This section provides basic information about the digital video editing facilities available in the basement of 
Peavy Hall.  Please refer to the print documentation provided in each edit bay and the software help sections 
for further information.  See section 2 for information regarding facility use and reservations.  Refer to this page 
as necessary when working through subsequent sections that refer to hardware located in the editing facility.

Editing Facility Overview
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#1:  Video Monitor - Review footage during import, editing, and export.

#2:  Speaker System Sub woofer - Make adjustments to treble & base; 
volume adjustment located on satellite speakers.

#3:  DV/VHS Player - Use this machine to import and export video (via 
FireWire) on DV cassette, VHS cassette, or an external device.

#4:  USB Audio Adaptor - Allows audio from microphone to enter the 
computer; use to adjust input levels (refer to #9).

#5:  PowerMac G5 CPU - Refer to 7 & 8 for more information.

#6:  Microphone - Use this microphone to record audio onto the 
computer; it has a separate ON/OFF switch.

#7:  Top to Bottom - PowerMac Power ON switch, headphone jack, 
USB input, FireWire input.

#8:  DVD+/-RW CD-RW Drive - Open/Close with keyboard commands.

#9:  Audio In Level - Use this knob to make adjustments to gain applied 
to audio recorded by the microphone (refer to #4). 10



Logging in and Accessing your Project File

An iMovie project fi le has already been created for you and is stored in your group’s folder on the external hard 
drive.  Follow the instructions below to login to the computer and open your video project.

• Press the power-on button (7) on the front of the computer’s case (5).  The PowerMac will begin loading 
and eventually bring you to a login screen.

• Once at the login screen, select your user name from the list and enter your group’s password; choose 
“login” and the computer will continue startup.

• Once you reach the main desktop, you will have access to all the fi les associated with your user account.  
To access your iMovie project fi le, double click on the “External HD” icon and navigate to your group’s 
folder.  To access other fi les (e.g. audio), double click the “Macintosh HD” icon.  Navigate to the fi les you 
wish to locate.  Double clicking on a fi le’s icon will launch the appropriate software package to open your 
fi le.  Your iMovie project fi le has been stored in your group’s folder on the external hard drive.

• iMovie and other applications can be opened by clicking on their icons in the dock at the bottom of the 
screen.  Holding the mouse over these icons will bring up a text description for further clarifi cation of each 
icon.  Most applications automatically open the project fi le that was in use when the computer was last 
shutdown; thus, launching an application will likely open the project fi le you wish to access.  If not, you 
can always choose “Open...” from the fi le menu to look for a project fi le.

Getting Started
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Important Tip - External Devices Connected to the PowerMac

External devices such as the DV/VHS Player (3) are connected to the computer by FireWire or USB.  You may 
also choose to plug additional devices (such as an iPod) into the computer (additional FireWire and USB ports 
are available on the front of the computer - #7).  These devices will automatically interface with the computer and 
launch the appropriate software, when applicable.  External storage devices (hard drives, USB fl ash memory 
sticks, etc.) will be “mounted” to the desktop and can be accessed by double clicking their respective icons.  It 
is important these devices be plugged in and turned on before opening applications that rely on them 
for input (i.e. be sure the DV/VHS player–#3–is on before launching iMovie).  If the computer loses 
communication with one of these devices, it may be necessary to quit the application, unplug the device 
from the computer, wait several seconds, plug the device back in, and then re-launch the application.

Common folders that are default locations 
for many different types of media can be 
found in the left column of the main Finder 
window.  Make use of these links to quickly 
navigate to fi les or folders you may wish to 
access.  Remember, your iMovie (video) 
project fi les should be saved in your 
group’s folder on the external hard drive.



The desktop is the main interface for your work in Mac OS X.  Available applications are shown in the “dock” 
at the bottom of the screen (see below).  If the “auto hide” feature is enabled, the dock will only appear 
when the mouse is moved into the lower part of the screen.  Click on a program’s icon once to open it.  
The program will launch in the desktop and its menu will be available in the menu bar at the top of the screen.  
You can run several programs at once; “hidden programs” are denoted by a small triangle under the program’s 
icon in the dock.  All available disks and network drives will be shown with an icon on the desktop; double click 
these icons to access the contents of a particular drive or disk.  To close a program, choose quit from the file 
menu.  For additional assistance, choose “Help” from the menu bar at any time and type a question 
into the Help Center dialog box.

 1  2  3 4   5 6  7  8      9

#1:  Finder:  Clicking on this icon at any time will cause all open applications to be placed in the background 
and open the finder window in the foreground.  The finder window provides access to files and folders 
located on the Macintosh HD and External HD.

#2:  System Preferences:  You can access system settings such as mouse tracking speed and desktop colors 
from System Preferences.

#3:  Safari:  Safari is Apple’s Web browsing utility; runs efficiently on Macintosh systems.

#4:  Internet Explorer:  Web browsing utility.

#5:  iMovieHD:  Capture, edit, and produce video—This is the editing software we use for the class!

#6:  iDVD:  Allows you to import video, create basic menu interfaces, and burn a DVD.

#7:  GarageBand:  Allows you to author original musical scores from a database of digitally recorded loops.

#8:  iTunes:  Play music CD’s, interface with an iPod, or download music from the iTunes store.

#9:  Trash:  Drag files you wish to delete here.  It is a good idea to delete unused files often to keep the 
maximum amount of storage space available at all times.  To empty the trash and permanently delete 
files, click on “Finder” in the menu bar and choose “Empty trash...”  You can also eject CD’s or 
disconnect from network drives by dragging their icons to the trash.

Introducing Mac OS X
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Important Tip - Opening & Closing the CD/DVD-ROM Drive
The CD/DVD-ROM drives on these PowerMac computers cannot 
be opened by pushing an external button.  Instead, the drive doors 
are operated by the uppermost, right-hand key on the keyboard 
(see picture left).  Push this key to open and close the drive doors.  
CD’s and DVD’s can also be ejected by dragging their icons to the 
trash.

System audio levels are controlled from the keyboard as well.



Introducing Apple’s iLife
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Important Tip - Accessing Your ONID Account

While most media files are too large to be stored in your ONID directory, you may occasionally find it useful to 
move files between ONID and the Mac.  From the main desktop, choose “Go” from the menu bar.  Select “Connect 
to Server” from the “Go” menu.  At the “Address” prompt in the dialog box, type “www.onid.orst.edu” and click 
“Connect.”  In the next dialog box (titled “Connect to the file server ‘ONID-FS’ as:”) enter your ONID user name at 
the “Name” prompt and your ONID password at the “Password” prompt; then choose “Connect.”  In the next dialog 
box (titled “ONID-FS”) select “Home” as the “volume you wish to mount”; then, choose “OK.”  Your ONID user 
space should now appear on the desktop with an icon titled “home.”  You can move files to and from this location.  
When you are finished, be sure to drag the “home” icon to the trash.  This will disconnect the computer from your 
ONID storage space.

iLife is Apple’s fully integrated consumer-level digital editing suite that allows seamless manipulation of media to 
produce finished products on CD, DVD, DV cassette, or VHS cassette.  iLife consists of iMovie, iDVD, iTunes, iPhoto, 
and GarageBand.

iMovie is of greatest interest to us in FOR 391; this software permits basic manipulation of digital video, 
including the addition of effects such as titles and transitions.  The remaining sections of this manual 
are devoted to a brief introduction to iMovie’s key features.  The other applications in the iLife suite 
interface directly with iMovie, allowing direct import and export of select media files.

iDVD allows users to author DVD’s that contain video, still images, data, or a combination of these 
media.  After importing media into the application from iMovie or other sources, iDVD automatically 
formats the material for playback on a standard DVD player.  The user interface enables you to 
choose from a variety of pre-designed menu elements, with limited options for customization.  Once all 
elements are complete, the application’s “burn” feature enables you to create DVD’s directly from the 
main user interface.

iTunes handles audio files and provides access to Apple’s online music download site.  iTunes can 
be used to play CD’s and import audio files onto the local drive from CD’s or other external devices.  
iTunes will interface with your iPod, allowing you to import music from your iPod into iMovie.  Songs can 
be purchased from the iTunes Music Store for $0.99 each.  iTunes also provides limited tools for audio 
file format conversion.

iPhoto handles digital pictures imported onto the computer from a digital camera or other storage 
device.  In most cases, iPhoto will interface with your camera and automatically import digital photos.  
The application offers powerful sorting and organization tools, with limited editing capabilities.  Photos 
can be imported into iMovie from iPhoto for use in video production; iPhoto also offers built-in utilities 
for authoring slide shows and other multimedia presentations that utilize still images.

GarageBand is a standalone consumer-level package that enables users to author their own musical 
compilations from an extensive library of digitally looped sounds.  GarageBand is a good source of 
“custom” sounds for specific effects needs or simple background melodies, but considerable skill is 
required to author an original musical score.



Transferring Video into iMovie from a DV Cassette

• To transfer digital video onto the computer, you will need to turn the DV/VHS player on (you should turn 
the unit on prior to opening iMovie).  Next, you insert your DV cassette into the player.  Ensure the pink 
“DV” button on the front of the player is highlighted; if it isn’t, push the button to select the DV side of the 
player.

• Return to the computer and locate the “switch” in the lower left corner of the video view window in iMovie 
(below--1).  You can either switch to the “DV camera icon” or the “scissors icon.”  Point the switch to the 
“DV camera icon.”  Once you have switched to the “DV camera icon,” the computer will interface with the 
DV/VHS player.  You can control the player with the buttons located on the screen (2).

• To import clips, click on the “Import” button (3) while the video you wish to capture is playing.  iMovie 
will automatically import the clips onto the computer.  You can stop the import by clicking on the “Import” 
button again.  If left alone, iMovie will automatically separate different shots and enter them as separate 
clips.  To stop transferring DV and begin working on your movie, point the switch to the “scissors icon” (1).

2
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Transferring Video into iMovie from a VHS Cassette

• Transferring video from a VHS Cassette is not much more difficult than transferring from a DV cassette.  It 
is important to note that this type of transfer requires the DV/VHS player to convert the video from analog 
to digital format; some quality will be lost during this process.

• Begin by turning the DV/VHS player on.  Next, insert your VHS cassette into the player.  Ensure the pink 
“S-VHS” button on the front of the player is highlighted; if it isn’t, push the button to select the S-VHS side 
of the machine.  You will also need to engage the S-VHS button associated with the “DUB” feature (refer 
to enlargement 10, page 4-1)--the green arrow should point from the S-VHS side of the machine to the DV 
side of the machine.

• Return to the computer and locate the “switch” in the lower left corner of the video view window in iMovie 
(above--1).  You can either switch to the “DV camera icon” or the “scissors icon.”  Point the switch to the 
“DV camera icon.”  Once you have switched to the “DV camera icon,” you are ready to import video.  
You will have to manually control playback from the DV/VHS player with the remote or buttons on the 
machine’s front panel, as iMovie cannot interface with the S-VHS side of the machine.

• To import clips, click on the “Import” button (3) while the video you wish to capture is playing.  iMovie 
will automatically import the clips onto the computer.  You can stop the import by clicking on the “Import” 
button again.  To stop transferring video and begin working on your movie, point the switch to the 
“scissors icon” (1).

Importing Video into iMovie
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iMovie features an easy-to-use interface that is based on the principle of “drag and drop.”  Nearly all of the 
editing and special effects features can be accessed and implemented with the mouse.  A very brief overview 
(designed to convey the general theory of operation) of the interface follows.  Take advantage of this 
information—along with the in-class orientation, the software’s help menu, and other materials—to get 
started with iMovie.  There is no substitute for “playing” with the program; teach yourself a few tricks!

The initial iMovie display consists of the main view screen, the clips pane, and the time line (shown above).  
The time line is where you will assemble your movie; this is where you drag and drop the video, transitions, 
titles, etc. that will comprise your production.  There are two modes/views for the time line; select between 
these with the buttons located beneath the main view screen.  It’s best to select the “clock mode” (see #1 
above) because this setting enables you to see the video and audio tracks, while also providing a visual 
representation of each component (video clips, transitions, etc.) of the video.

Once you have transferred, or digitized, your video from the DV cassette, the individual video segments will 
be displayed in the clips pane with an image of the clip’s fi rst frame and a generic title.  To edit a clip, click 
on it once to load it into the viewer.  Unwanted segments of a clip can be removed by adjusting the editing 
handles (2) to highlight the section that you wish to keep.  Drag the handles with the mouse or make precise 
adjustments using the arrow keys.  Once you have highlighted the section you want to keep in yellow, choose 
“Crop” from the Edit menu.  The “extra” video will be trimmed off.  When you are happy with your edit, drag the 
clip into the time line at the desired location.  You can also select clips already in the time line and edit them in 
the same manner.

iMovie offers an alternative to this “destructive editing” method.  You also have the option of moving clips 
directly into the time line and editing them by sliding the ends of the clip in or out with the mouse.  This method 
essentially “covers up” the part of the clip you do not want to display in your video; it can be revealed at any 
time by sliding the end of the clip in the opposite direction.  This editing method works for both audio and video 
tracks.

Volume levels for video and audio clips can be adjusted by choosing “Show Audio Levels” from the View menu.  
This option causes a line to appear through each clip; the line represents the volume level.  You can adjust 
the volume level of clips in the time line by making changes to the volume level indicator—a solid line running 
through each clip.  Clicking on this line will create a key point—or pivot point—around which you can make 
changes to the volume level.  Important Note:  When you have the “Show Audio Levels” turned on, it is 
not possible to edit clips by the non-destructive method explained above.

It is also possible to “split a clip” at the playhead.  This feature allows you to create two audio or video 
segments out of one clip.  It is useful for making more complex edits (especially with audio).  To split a clip, 
position the playhead (3) at the location where you desire the split.  Then, choose “Split Clip at Playhead” from 
the Edit menu.  Once split, the clips are independent and can be edited accordingly.  This is particularly helpful 
if you want to insert text over your video footage at point midway through a clip.

1 2

Time Line
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All of iMovie’s major features can be accessed through the tool bar (below).  Images, audio segments, and 
effects (transitions, titles, etc.) can be added to the time line by dragging them with the mouse to the desired 
location.  Aspects of the various effects, including timing, can be customized using the controls available in 
each menu.  In many instances, media already imported into other iLife applications will automatically be 
visible in iMovie; you can drag and drop these items.  You also have the option of importing media directly into 
iMovie by choosing “Import...” from the File menu.

Working with Audio

You may add audio tracks from CD’s currently in the CD drive, files on the computer’s hard drive (in iTunes) 
or another location, or record your own narrative.  Utilize the menu selector at the top of the audio menu to 
choose between iMovie sound effects, an audio CD, or iTunes; available audio tracks will appear in the window 
(drag them into place and edit as necessary).

Record your own narrative with the microphone available in the edit bays.  To begin, switch the microphone 
on (switch located near bottom of foam windscreen).  The computer is already configured to accept audio 
input from this microphone.  Before recording your narrative, use the meter in the audio menu to adjust the 
microphone levels.  Speak into the microphone and adjust the input volume control on the USB audio device 
(refer to #9, page 4-1) so that the meter rarely peaks into the “red zone.”  Once the microphone is adjusted, 
record your narrative by clicking on the red record button and speaking into the microphone.  The audio will be 
recorded into one of the two audio tracks in the time line; edit as necessary.  Remember, it may require multiple 
takes to get everything adjusted properly.  In general, it’s a good idea to position the microphone at an angle 
to your mouth, approximately two inches away.  This set-up will optimize sound quality by minimizing the risk 
of “popping” and other audio defects.  Don’t forget to turn the microphone off when shutting the system 
down.

Effects Audio Images

Working in iMovie

FOR 391 Video Project Student Guide          Section 4-7



Exporting from iMovie to iDVD
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Once you have completed work on your video, you’ll want to produce it on some form of media for distribution.  
iMovie offers many options for exporting your movie.  The equipment available in the edit bays enables you to 
produce on DVD, mini DV Cassette, or VHS cassette.  For the purposes of FOR 391, you’ll need to burn 
your video onto a DVD; bring the DVD to class on the date of your fi nal presentation.

Before creating your DVD, save all your work, quit iMovie, and restart the computer!  Experience has 
shown this step improves reliability of the DVD-burning process.

iMovie integrates with iDVD.  To begin the process,
select the iDVD tab on the main tool bar.

Once the iDVD tab opens, select the option allowing you to “Create an iDVD Project.”  This step will launch 
iDVD and import your movie.  iDVD automatically begins the process of converting your video fi le to a format 
that will play in most DVD players (MPEG-2); it also places a link to your movie in the menu interface.

The menu interface is a key feature of any DVD.  This is the display--or interface--a user sees when they insert 
your DVD into the player; it’s also the interface that allows them to access and view the DVD contents (in this 
case your video).  iDVD has a number of pre-
designed menu interfaces, each with features 
that can be customized by the user.

To begin customizing your DVD, click on the 
“Customize” button in the lower left corner of 
the iDVD interface (1).  This will open another 
window with a tool bar across the top.  Peruse 
the available themes and make a selection.  
Once you settle on a theme, you can make 
additional custom selections.

“Drop Zones” are areas where you can drag 
and drop images or video fi les.  To drop a 
media fi le into one of these zones, locate it 
on the computer (hard drive, ONID account, 
CD, etc.) and drag its icon on the drop zone.  
Releasing (dropping) the icon over the zone will 
cause it to fi ll in the drop zone area.  You can also add or change the background music by dropping an audio fi le 
of your selection anywhere within the interface.

You can make text changes to the menu title and the default name given to your movie by clicking on them and 
making edits with the keyboard.  Changes to fonts, sizes, colors, arrangement, etc. are achieved by selecting the 
“Settings” tab (2) and entering custom values for these variables.

Clicking on the “Preview” button (3) enables you to view a simulated version of the DVD as it will appear when 
played in a standard DVD player.

Once you are satisfi ed with the layout of your DVD, you’re ready to burn.  Select the “Burn” button (4).  iDVD 
will open the DVD-ROM drive.  Insert a blank DVD-R (be sure your media is DVD-R--this is required for FOR 
391) into the drive and close the drive using the upper, right-hand key on the keyboard (refer to 4-3).  iDVD will 
automatically read the media you have inserted and begin the burning process.  Once the DVD is complete, it 
will be ejected and iDVD will ask if you would like to burn another.  After you have fi nished burning DVD’s, save 
your work and quit the application.
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Exporting from iMovie to a DV Cassette

• To export your video from iMovie to a DV cassette, begin by turning on the DV/VHS player and verify the 
“DV” button is illuminated pink (if not, press it to activate the DV side of the machine).  Then, turn on the 
video monitor.  The monitor should display a blue screen with “F1” in the upper left corner.

• If “F1” is not displayed, you will need to locate the remote control and press the CH+ or CH- button to 
change the channel to “F1.”

• Insert a non-write protected DV cassette into the player and cue it to a blank portion of the tape (this is 
where your video will begin).

• Return to the computer and choose “Share Movie” from the File Menu.  Select the video camera option 
from the icons in the dialog box.  Under the video camera tab, change the settings to allow 10 seconds of 
black before and after the video, as well as 5 seconds for the camera to get ready.

• Click the share button.  The computer will interface with the DV/VHS machine to complete the operation.  
Once finished, the tape can be rewound and/or ejected from the machine.

Dubbing from a DV Cassette to a VHS Cassette

• Turn on the DV/VHS player and load both cassettes.  You will need to engage the S-VHS button 
associated with the “DUB” feature (refer to enlargement 10, page 4-1)--the green arrow should point from 
the S-VHS side of the machine to the DV side of the machine.

• Activate the DV side of the machine by pressing the pink “DV” button.  Locate the start of your movie on 
the DV cassette.  Once there, press “Play” and immediately press “Pause.”

• Activate the S-VHS side of the machine by pressing the pink “S-VHS” button.  Locate the point on your 
tape where you would like the video to begin.  Press “Record” and let it run for 3-5 seconds.

• Activate the DV side of the machine.  Press “Play” to release the pause on the DV cassette.  The machine 
will now dub from the DV cassette to the VHS cassette.

• Once the dub is complete, stop both tapes, rewind, and eject.

Finishing Up...

Shutting Down the Computer & Facility

• When you are done with the computer, quit all applications (be sure to save any changes).

• Click “Finder” on the menu bar and select “Empty Trash.”

• If you accessed your ONID storage space, drag the “home” icon to the trash to disconnect from the drive.

• Click on the “Apple” icon in the left corner of the menu bar.  Select “Shut Down” and then confirm your 
choice.  The computer will now turn off.  Wait and verify that the computer has properly shut down and 
turned itself off.

• Turn off all other equipment.  This includes video monitors and the DV/VHS player.

• Take a moment to collect any trash, neaten things up, turn off the lights, and lock the doors.
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